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PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022

dalam menghasilkan sarjana ilmu komunikasi yang memiliki kecerdasan spiritual,
intelektual, emosional, dan sosial serta berjiwa entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk

menghasilkan sarjana yang unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan
memanfaatkan aplikasi teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses
pemantapan dan pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan
dengan komunikasi massa, humas, periklanan, penyiaran, dan manajemen
komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan
dan teknologi, menuju keluhuran akhlak.



• SKS : 3
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Keaktifan, Etika, dan Sikap).

• Project (bobot 25%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara

observasi, mengimplementasikan dan menghasilkan Proyek Akhir, serta
mempresentasikannya.

• Tes (UTS = bobot 25% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes

tertulis maupun tes praktikum.

Sistem Penilaian
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• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Pengantar & Silabus.

• Deskripsi Singkat
– Mata kuliah ini membahas ruang lingkup komputer grafis meliputi pengenalan

toolbox, document window, pallet, viewing mode, teknik menggambar, membuat
efek, kompisisi warna, pengeditan dan photoshop.

• Indikator Kompetensi.
– Mahasiswa mengetahui rencana pembelajaran yang akan diberikan selama satu

semester.

– Mahasiswa mengetahui buku-buku dan referensi yang digunakan didalam mata
kuliah ini.

– Mahasiswa mampu memahami dan mengetahui kontrak belajar.

Tujuan/Objectives (Session.01)
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Muhasabah
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• Qs. Al-Alaq, ayat 1 s/d 5

– Bacalah dengan (menyebut) nama Tuhanmu yang menciptakan,

– Dia telah menciptakan manusia dari segumpal darah.

– Bacalah, dan Tuhanmulah Yang Mahamulia,

– Yang mengajar (manusia) dengan pena.

– Dia mengajarkan manusia apa yang tidak diketahuinya.
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Pengantar & Silabus
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RPS/SAP;

Rencana Pembelajaran Semester /
Satuan Acara Perkuliahan. 



RPS / SAP

Session 01
- Perkenalan dan Silabus.
- Buku dan Referensi.

Session 02
- Vector Image & Bitmap
- Mengenal Lingkungan Kerja Photoshop.

Session 03
- Setting Area Kerja.

Session 04
- Teknik Kombinasi.
- Aplikasi Gambar Dengan Bentuk Dasar.

Session 05
- Menggambar Dengan Pencil Tools.
- Menggambar Garis.

Session 06
- Selection Tools.

Session 07
- Efek Twist.
- Envelope.
- Editing Content.

Session 08
- U.T.S.
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RPS / SAP
(lanjutan)

Session 09
- Menggunakan Type Tools.
- Point Text, Menyunting Text, Area Text.

Session 10
- Compund Path.
- Shape.

Session 11
- Photomerge.
- Transformasi.

Session 12
- Teknik Penulisan Teks.

Session 13
- Filter Effect.

Session 14
- Editing Foto.
- Efek di Photoshop.

Session 15
- Presentasi

Session 16
- U.A.S.
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Pendahuluan;

Referensi dan Buku-Buku



Tools
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Buku-Buku

• Anderson, David. (2014). Graphics in Design & Communication, One
Volume Edition. CRC Press.
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Buku-Buku

• Schwartz, Rob. (2016). Learn Adobe Photoshop CC for Visual
Communication: Adobe Certified Associate Exam Preparation, 1st edition.
Adobe Press.
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Buku-Buku

• Obermeier, Barbara., Padova, Ted. (2020). Photoshop Elements 2020 For
Dummies, 1st Edition.
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Referensi

• Anderson, David. (2014). Graphics in Design & Communication, One Volume Edition.
CRC Press.

• Schwartz, Rob. (2016). Learn Adobe Photoshop CC for Visual Communication: Adobe
Certified Associate Exam Preparation, 1st edition. Adobe Press.

• Obermeier, Barbara., Padova, Ted. (2020). Photoshop Elements 2020 For Dummies, 1st

Edition.

• adobe.com, 2021,. Photoshop Tutorials: Learn How To Use Photoshop,
https://helpx.adobe.com/photoshop/tutorials.html.
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Terima Kasih
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PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Pengenalan Komputer Grafis.

• Deskripsi Singkat
– Mata kuliah ini membahas ruang lingkup komputer grafis meliputi pengenalan toolbox,

document window, pallet, viewing mode, teknik menggambar, membuat efek,
komposisi warna, pengeditan menggunakan perangkat lunak Adobe Photoshop.

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang faktor-faktor penyebab muncul dan
berkembang bidang ilmu komputer grafis.

– Mahasiswa mengetahui dan memahami tentang perbedaan picture dengan photo, dan
perbedaan raster image dengan vector image.

– Mahasiswa mengetahui dan memahami tentang sejarah dari komputer grafis.

Tujuan/Objectives (Session.02)

4



18/09/2023

2

Muhasabah

• Qs. Al-Asr, ayat 1 - 3
– Demi masa (waktu)

– sungguh, manusia berada dalam kerugian,

– kecuali orang-orang yang beriman dan mengerjakan kebajikan serta saling menasihati untuk kebenaran
dan saling menasihati untuk kesabaran.

5

Komputer Grafis

Session 02

Pengenalan Komputer Grafis
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Pengenalan Komputer Grafis

Pendahuluan

Pendahuluan

• Komputer Grafis / Grafika komputer (Inggris: Computer Graphics).

• Merupakan bagian dari ilmu komputer yang berkaitan dengan pembuatan dan
manipulasi gambar (visual) secara digital.

• Komputer Grafis meliputi:

– Hardware

– Software

– Applications

8

http://id.wikipedia.org/wiki/Bahasa_Inggris
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Pendahuluan
(lanjutan)

• Hardware
– PC yang dilengkapi dengan kartu grafis/graphics card (VGA), dan digunakan untuk

pemodelan, rendering, dll.

• Software
– Perangkat lunak khusus untuk modeling dan rendering yang dibangun (develop)

berdasarkan atau di-atas OpenGL.

• OpenGL (Open Graphic Library) merupakan library yang terdiri dari berbagai macam fungsi dan 
biasanya digunakan untuk menggambar sebuah atau beberapa objek 2 dimensi dan 3 dimensi.

• Applications
– Merupakan objek yang ditampilkan pada software dan dibuat oleh artist.

9

Pendahuluan
(lanjutan)

10

Pendahuluan
(lanjutan)

• Grafika komputer adalah suatu bidang ilmu yang mempelajari bagaimana
membangun grafik (gambar) baik 2D maupun 3D yang kelihatan nyata
menggunakan komputer.

• Salah satu bidang grafika komputer

yang sangat terkenal adalah desain grafis.

11

Apa yang perlu diperkenalkan

• Penggunaan komputer, perangkat lunak, kamera digital, pemindai, digital

tablet, dan printer untuk menciptakan citra digital 2D dan 3D.

• Langkah untuk menghasilkan karya seni citra obyek dan nonobyek langsung

dari komputer dengan atau tanpa pemindai:

• Vector Graphic, misalnya dengan Adobe Illustrator, Corel Draw

• Bit Mapped atau Raster Graphic, misalnya dengan Adobe Photoshop, Paintshop Pro,

Painter 9, Gimp

• Pemodelan 3D , misalnya dengan Autocad, 3D, Blander

12



18/09/2023

4

13

Pengenalan Komputer Grafis

Faktor Penyebab

Faktor Penyebab

• Beberapa faktor yang mendorong
komputer grafis:

a) Movie Industries

b) Game Industries

c) Medical Imaging

d) Scientific Visualization

e) Computer Aided Design

f) Graphics User Interface

g) Advertising

14

Faktor Penyebab
(lanjutan)

a) Movies Industries

– Industri perfilman.

– Misalnya dalam 
pembuatan film 
animasi, atau dalam 
film yang 
menggunakan efek 
visual yang canggih.

15 16
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Faktor Penyebab
(lanjutan)

b) Game Industries

– Industri Video Game.

17

Faktor Penyebab
(lanjutan)

18

Faktor Penyebab
(lanjutan)

c) Medical Imaging

– Pencitraan Medis

19

Faktor Penyebab
(lanjutan)

20
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Faktor Penyebab
(lanjutan)

d) Scientific Visualization

21

Faktor Penyebab
(lanjutan)

e) Computer Aided Design (CAD)

22

Faktor Penyebab
(lanjutan)

23

Faktor Penyebab
(lanjutan)

f) Graphics User Interface (GUI)

24
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Faktor Penyebab
(lanjutan)

25

g) Advertising & Entertainment

26

Faktor Penyebab
(lanjutan)

27

Faktor Penyebab
(lanjutan)

28

• Komputer grafis bidang seni berkembang terkait bidang industri

– Perfilman

– Permainan (games)

– Komunikasi Visual: iklan dan publishing dll.

– Desain produk

– Desain interior

– Dll.
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29

Pengenalan Komputer Grafis

Picture

Picture

• Foto merupakan gambar yang dihasilkan
dengan proses capture dari kegiatan nyata.

• Hasilnya setiap detail akan muncul persis
dengan sebenarnya.

– Misalnya jumlah kumis pada kucing sama.

• Gambar adalah proses pembentukan yang
dilakukan dengan meniru kegiatan nyata.

• Hasilnya ada beberapa detail yang tidak
dapat ditampilkan/terlewatkan.

– Siapa yang peduli pada jumlah kumis pada
kucing saat menggambar.

30

Picture
(lanjutan)

• Macam-macam gambar didalam komputer, terdiri dari:

– Raster Image

– Vector Image

31

Picture
(lanjutan)

• Raster Image

– Merupakan gambar yang strukturnya berupa matriks.

– Dimana setiap titik (x,y) mempunyai nilai berupa warna yang digunakan seperti RGB
atau CYMK.

– File dengan ekstensi BMP, GIF, TIFF, JPG, dan PNG merupakan contoh dari Raster Image.

• Vector Image

– Merupakan gambar yang strukturnya berupa vektor.

– Gambar yang dibuat menggunakan AutoCAD atau CorelDraw atau gambar-gambar pada
GIS.

– File dengan ekstensi AI, EPS, CGM, SVG, dan CR merupakan contoh dari Vector Image.

32
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Picture
(lanjutan)

Picture History.

• Tahun 1950-an

• Tahun 1960-an

• Tahun 1970-an

• Tahun 1980-an

• Tahun 1990-an

• Tahun 2000-2001

33

Picture
(lanjutan)

Tahun 1950-an.

• Output/keluarannya via teletypes, lineprinter, dan cathode ray tube (CRT).

• Menghasilkan suatu picture yang direproduksi menggunakan karakter gelap
dan terang.

34

Picture
(lanjutan)

Tahun 1960-an.

• Merupakan permulaan grafik interaktif modern, keluarannya adalah grafik
vektor dan grafik interaktif.

• Kekurangannya adalah pada biaya yang sangat mahal.

35

Picture
(lanjutan)

Tahun 1970-an.

• Output/Keluaran sudah raster image, kemampuan grafis
masih tipis dan tebal.

• Contoh : Video arcade game, film “Westword” (film
pertama kali menggunakan CG), Apple II dengan warna
grafik komputer pribadi.

36
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Picture
(lanjutan)

Tahun 1980-an.

• Keluarannya adalah grafik raster built-in, gambar bitmap, dan pixel.

• Biaya–biaya yang dikeluarkan berkurang secara drastis, oleh karena munculnya
komputer pribadi (personal computer).

• Trackball dan mouse menjadi alat interaktif yang sering digunakan.

37

Picture
(lanjutan)Tahun 1990-an.

• Sejak diperkenalkan VGA, SVGA, komputer
pribadi bisa dengan mudah menampilkan
gambar hidup dan gambar photo-realistik dan
juga gambar 3D rendering, yang merupakan
kemajuan utama dan mampu merangsang
aplikasi grafik sinematik (CG).

38

Picture
(lanjutan)

Tahun 2000-2001.

• Munculah NVIDIA Corporation , GeForce 256, dan GeForce3.

39

Referensi

• Anderson, David. (2014). Graphics in Design & Communication, One Volume Edition. CRC
Press.

• Schwartz, Rob. (2016). Learn Adobe Photoshop CC for Visual Communication: Adobe
Certified Associate Exam Preparation, 1st edition. Adobe Press.

• Obermeier, Barbara., Padova, Ted. (2020). Photoshop Elements 2020 For Dummies, 1st

Edition.

• adobe.com, 2021,. Photoshop Tutorials: Learn How To Use Photoshop,
https://helpx.adobe.com/photoshop/tutorials.html.
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Terima Kasih
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Komputer Grafis

Session 03

PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Workspace and Workflow

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang workspaces (area kerja) pada
photoshop dan workflow (alur kerja) pada photoshop.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang cara membuka
dan menyimpan gambar, memperbesar dan memperkecil gambar, serta membatalkan
kesalahan, mengubah ukuran gambar, memotong dan meluruskan, menambahkan ke
kanvas gambar.

Tujuan/Objectives (Session.03)
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Muhasabah

• Qs. Al-Baqarah, ayat 132
– Dan Ibrahim mewasiatkan (ucapan) itu kepada anak-anaknya, demikian pula Yakub.

– “Wahai anak-anakku! Sesungguhnya Allah telah memilih agama ini untukmu, maka janganlah kamu mati
kecuali dalam keadaan Muslim.”

5

Komputer Grafis

Session 03

Workspace & Workflow

7

Workspace & Workflow

Workspace Overview

Workspace Overview

• Anda dapat membuat dan memanipulasi dokumen serta file menggunakan
berbagai elemen, seperti:

– Panels (panel)

– Bars (bilah)

– Windows (jendela)

• Semua pengaturan elemen diatas disebut ruang kerja (workspace).

8
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Workspace Overview
(lanjutan)

• Bilah menu (di bagian paling atas) menampilkan File, Edit, Gambar, dan menu
lain yang memberi Anda akses ke berbagai perintah, penyesuaian, dan panel.

• Bilah opsi (di bawah bilah menu) menampilkan opsi untuk alat yang sedang
Anda gunakan.

• Panel alat (di sebelah kiri) berisi alat untuk mengedit gambar dan membuat
karya seni.

• Alat serupa dikelompokkan bersama.

• Anda dapat mengakses alat terkait dalam grup dengan mengklik dan menahan
alat di panel.

9

Workspace Overview
(lanjutan)

• Panel (di sebelah kanan) menyertakan Warna, Lapisan, Properti , dan panel lain
yang berisi berbagai kontrol untuk bekerja dengan gambar.

• Anda dapat menemukan daftar lengkap panel di bawah menu Window.

• Jendela dokumen (di tengah) menampilkan file yang sedang Anda kerjakan.

• Beberapa dokumen terbuka muncul di tab di jendela Dokumen

10

11

Default Illustrator workspace

A. Tabbed Document windows

B. Application bar

C. Workspace switcher

D. Panel title bar

E. Control panel

F. Tools panel

G. Collapse To Icons button

H. Four panel groups in vertical dock

Workspace Overview
(lanjutan)

Tool Galleries

12
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Tool Galleries
(lanjutan)

13

Tool Galleries
(lanjutan)

14

Tool Galleries
(lanjutan)

15

Tool Galleries
(lanjutan)

16
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Tool Galleries
(lanjutan)

17

Tool Galleries
(lanjutan)

18

Tool Galleries
(lanjutan)

19

Tool Galleries
(lanjutan)

20
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Tool Galleries
(lanjutan)

21 22

Workspace & Workflow

Get to know Photoshop Basics

Open & Close an Image

Video materi tutorial ini dapat dilihat di OLU ”Support Materia 1”, atau melalui
laman https://helpx.adobe.com/photoshop/tutorials.html

--> ”Get to know Photoshop”.

• Tutorial ini memperkenalkan Anda ke area kerja Photoshop dan menunjukkan:

– Mengubah ukuran gambar

– Memotong dan meluruskan

– Menambahkan ke kanvas gambar

23

Open & Close an Image
(lanjutan)

Buka gambar

• Buka gambar, dan buat gambar baru.

Untuk membuka dan membuat gambar

• Di bar menu, pilih File > Open

– untuk membuka gambar yang sudah ada.

• Di bilah menu, pilih File > New

– untuk membuat gambar baru dari awal.

Tutup gambar:

• Pilih File > Close

24

https://helpx.adobe.com/photoshop/tutorials.html
https://helpx.adobe.com/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json&ref=helpx.adobe.com
https://helpx.adobe.com/sea/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_SEA.json&ref=helpx.adobe.com
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Get Familiar with the work area

25

Jelajahi area kerja

Zoom & Hand

26

Untuk memperbesar, memperkecil,
dan menggeser ke sekeliling gambar

• Zoom Tool, terletak di panel Alat.
– Ubah dari Zoom In ke Zoom Out di

bilah opsi.

• Hand Tool, juga terletak di panel
Alat,
– memungkinkan Anda untuk

menggeser gambar besar atau yang
diperbesar.

Undo & Redo

Untuk membatalkan

• pilih Edit > Batalkan atau tekan
Control + Z.
– Untuk membatalkan hal terakhir yang Anda

lakukan

• pilih Edit > Ulangi atau tekan lagi
Control + Z.
– Untuk mengulangi hal terakhir yang Anda lakukan

• pilih Edit > Step Backward beberapa
kali, atau pilih satu langkah di History
Panel.
– Untuk membatalkan beberapa langkah,

27

Save your work

Untuk menyimpan gambar

• Pilih File > Save atau File > Save As

– Menyimpan dalam format Photoshop (.psd)
akan mempertahankan lapisan, jenis, dan
properti Photoshop lain yang dapat diedit.
Sebaiknya simpan gambar Anda dalam format
PSD saat Anda masih mengerjakannya.

– Menyimpan dalam format JPEG (.jpg) atau PNG
(.png) akan disimpan sebagai file gambar standar
yang dapat dibagikan, dibuka oleh program lain,
dan diposting online.

28

https://helpx.adobe.com/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json&ref=helpx.adobe.com
https://helpx.adobe.com/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json&ref=helpx.adobe.com
https://helpx.adobe.com/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json&ref=helpx.adobe.com
https://helpx.adobe.com/photoshop/how-to/ps-basics-fundamentals.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json&ref=helpx.adobe.com
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29

Workspace & Workflow

Change the Image Size

Change the Image Size

Video materi tutorial ini dapat dilihat di OLU ”Support Materia 2”, atau melalui
laman https://helpx.adobe.com/photoshop/tutorials.html

--> ”Change the image size”.

• Tutorial ini memperkenalkan Anda ke area kerja Photoshop dan menunjukkan:

– Mengubah ukuran gambar

– Memotong dan meluruskan

– Menambahkan ke kanvas gambar

30

Change the Image Size
(lanjutan)

Untuk mengubah ukuran gambar

• Pilih Image > Image Size .

• Ukur lebar dan tinggi dalam piksel untuk gambar
yang akan Anda gunakan secara online atau
dalam inci (atau sentimeter) untuk gambar yang
akan dicetak. Biarkan ikon tautan disorot untuk
mempertahankan proporsi. Maka secara
otomatis menyesuaikan ketinggian saat Anda
mengubah lebar dan sebaliknya.

• Pilih Resample untuk mengubah jumlah piksel
pada gambar. Pilihan ini akan mengubah ukuran
gambar.

• Klik OK.
31

Change the Image Size
(lanjutan)

Untuk mengubah resolusi gambar

• Pilih Image > Image Size . Resolusi dalam
kotak dialog ini berarti jumlah piksel gambar
yang akan ditetapkan ke setiap inci saat gambar
dicetak.

• Biarkan lebar dan tinggi disetel ke inci untuk
pencetakan.

• Batalkan pilihan Resample untuk
mempertahankan jumlah asli piksel gambar.

• Pada menu Resolution , setel jumlah piksel
per inci ke 300 untuk pencetakan ke printer
inkjet desktop biasa. Ini akan mengubah jumlah
inci di bidang lebar dan tinggi.

• Klik OK.
32

https://helpx.adobe.com/photoshop/tutorials.html
https://helpx.adobe.com/photoshop/how-to/image-resizing-basics.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json
https://helpx.adobe.com/photoshop/how-to/image-resizing-basics.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json
https://helpx.adobe.com/photoshop/how-to/image-resizing-basics.html?playlist=/services/playlist.helpx/products:SG_PHOTOSHOP_1_1/learn-path:get-started/set-header:ccx-designer/playlist:ccl-get-started-1/en_us.json
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Change the Image Size
(lanjutan)

Untuk memotong dan meluruskan gambar

• Pilih tool Crop di panel Alat . Sehingga muncul garis
potong.

• Seret tepi atau sudut mana pun untuk menyesuaikan
ukuran dan bentuk batas pemangkasan.

• Seret di dalam batas pemangkasan untuk
memposisikan gambar di dalam batas pemangkasan.

• Seret di luar sudut batas crop untuk memutar atau
meluruskan.

• Klik tanda centang di bilah opsi atau tekan Enter

(Windows) atau Return (macOS) untuk
menyelesaikan pemangkasan.

33

Change the Image Size
(lanjutan)

Untuk mengubah ukuran kanvas

• Pilih Image > Canvas Size

• Untuk menambahkan kanvas, masukkan
jumlah lebar dan tinggi yang akan
ditambahkan. Ukur lebar dan tinggi dalam
satuan piksel untuk penggunaan online atau
dalam satuan inci untuk keperluan pencetakan.

• Pilih Relative , lalu pilih titik jangkar di
diagram kanvas. Panah akan menunjuk ke sisi
tempat kanvas akan ditambahkan.

• Klik OK .

34
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PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Drawing & Transformation

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang drawing dan transformation pada
photoshop.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang primitive
drawing, obyek grafik 2D, transformasi 2D, obyek grafik 3D, transformasi 3D, morphing.

Tujuan/Objectives (Session.04)

4
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Muhasabah

• Qs. Al Baqarah, ayat 183
– Wahai orang-orang yang beriman! Diwajibkan atas kamu berpuasa sebagaimana diwajibkan atas orang

sebelum kamu agar kamu bertakwa,

5

Komputer Grafis

Session 04

Drawing & Transformation

7

Drawing & Transformation

Drawing

Primitive Drawing

8
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Drawing
(lanjutan)

• Menggambar obyek-obyek dasar grafik yang berupa: titik, garis, polyline,
polygon.

• Memberikan warna pada obyek grafik misalkan dengan setcolor, fillpolygon,
gradatepolygon.

9

Drawing
(lanjutan)

• Objek 2D

10

Drawing
(lanjutan)

• Objek 3D

11 12

Drawing & Transformation

Transformation
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Transformation

• Macam-macam transformasi untuk objek 2D & 3D, seperti:

– Translation (pindah)

– Rotation (berputar)

– Scaling (berubah ukuran).

13

Transformation
(lanjutan)

14

Transformation
(lanjutan)

15 16

Drawing, & Transformation

Photoshop Tools
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Tools

17

Marquee Tools

• Dan pada pengaturannya kita dapat mengeluarkan Option pada menu window,
berikut tampilannya.

18

Marquee Tools
(lanjutan)

• Marquee Tool berfungsi untuk menyeleksi objek.

• Marquee Tool dibagi menjadi 4, yaitu:

1. Rectangular Marquee Tool (shortcut keyboard: M)

• berfungsi untuk menyeleksi objek berbentuk kotak/segi-empat.

2. Elliptical Marquee Tool (shortcut keyboard: M)

• berfungsi untuk menyeleksi objek berbentuk lingkaran/elips.

3. Single Row Marquee Tool

• berfungsi untuk menyeleksi objek dengan garis horizontal.

4. Single Column Marquee Tool

• berfungsi untuk menyeleksi objek dengan garis vertikal.

19

Lasso Tools

• Dan pada pengaturannya kita dapat mengeluarkan Option pada menu window,
berikut tampilannya dengan menggunakan Polygonal Lasso Tool.

20
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Lasso Tools
(lanjutan)

• Lasso Tool juga berfungsi untuk menyeleksi objek, tetapi dalam bentuk yang
bebas.

• Lasso Tool dibagi menjadi 3, yaitu:

1. Lasso Tool (shortcut keyboard: L)

• berfungsi untuk menyeleksi objek dalam bentuk bebas sesuai keinginan.

2. Polygonal Lasso Tool (shortcut keyboard: L)

• berfungsi untuk menyeleksi objek dalam bentuk garis-garis bebas.

3. Magnetic Lasso Tool (shortcut keyboard: L)

• menyeleksi objek dengan garis yang otomatis menempel pada objek yang
diseleksi.

21

Quick Selection & Magic Wand Tools

• Perbedaan toleransi warna dapat diatur pada tool option bar, kita dapat
mengeluarkan Option pada menu window, berikut tampilannya dengan
menggunakan Magic Wand Tool.

22

Quick Selection & Magic Wand Tools
(lanjutan)

• Quick Selection & Magic Wand Tool (W), Untuk menyeleksi gambar yang
memiliki warna sama .

1. Quick Selection Tool (shortcut keyboard: W)

• berfungsi untuk menyeleksi area secara bebas berdasarkan warna atau pixel.

2. Magic Wand Tool (shortcut keyboard: W)

• berfungsi untuk menyeleksi objek berdasarkan warna yang sama.

23
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Komputer Grafis

Session 05

PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Start Your Design

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang bagaimana memulai suatu desain
pada komputer grafis.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang batasan-batasan
pada desain grafis, kategori didalam desain grafis, dan langkah-langkah didalam proses
desain grafis.

Tujuan/Objectives (Session.05)

4
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Muhasabah

• Qs. Al Baqarah, ayat 185
– Bulan Ramadan adalah (bulan) yang di dalamnya diturunkan Al-Qur'an, sebagai petunjuk bagi manusia dan

penjelasan-penjelasan mengenai petunjuk itu dan pembeda (antara yang benar dan yang batil).

– Karena itu, barangsiapa di antara kamu ada di bulan itu, maka berpuasalah. Dan barangsiapa sakit atau dalam
perjalanan (dia tidak berpuasa), maka (wajib menggantinya), sebanyak hari yang ditinggalkannya itu, pada hari-
hari yang lain. Allah menghendaki kemudahan bagimu, dan tidak menghendaki kesukaran bagimu.

– Hendaklah kamu mencukupkan bilangannya dan mengagungkan Allah atas petunjuk-Nya yang diberikan
kepadamu, agar kamu bersyukur.

5

Komputer Grafis

Session 05

Start Your Design

7

Start Your Design

Pendahuluan

Apa itu desain grafis ?

• Desain grafis adalah proses untuk menciptakan tampilan sebuah publikasi,
presentasi, atau di situs web yang menarik, dengan cara logis.

• Desain grafis adalah suatu bentuk komunikasi visual yang menggunakan
teks dan atau gambar untuk menyampaikan informasi atau pesan.

• Ketika desain selesai maka:

– Menarik perhatian - Simpel

– Menambah nilai - Ter-organisir

– Meningkatkan minat audiens - Memberikan penekanan selektif

– Menciptakan kesatuan yang utuh.

8
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Powered 
by 

Text

9

Powered 
by 

Software

10

Powered
by

Photo

11

Bagaimana memulai belajar Desain Grafis ?

• Memahami batasan-batasan pada desain grafis.

• Mulai berkenalan dengan software dan aplikasi desain grafis.

• Pengalaman adalah guru yang paling berharga, oleh karena itu mulailah
berkreasi !

12
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Start Your Design

Kategori Design Grafis

Kategori Desain Grafis

• Secara garis besar, desain grafis dibedakan menjadi beberapa kategori:

1. Printing (Percetakan).
• yang memuat desain buku, majalah, poster, booklet, leaflet, flyer, pamflet, periklanan,

dan publikasi lain yang sejenis.

2. Web Design
• desain untuk halaman web.

3. Film termasuk CD, DVD, CD multimedia untuk promosi.

4. Identifikasi (Logo), EGD (Environmental Graphic Design)
• merupakan desain profesional yang mencakup desain grafis, desain arsitek, desain

industri, dan arsitek taman.

5. Desain Produk, Pemaketan, dan sejenisnya.

14

Aplikasi Pengolah Tata Letak (Layout)

• Program ini sering digunakan untuk keperluan pembuatan brosur, pamflet,
booklet, poster, dan lain yang sejenis.

• Program ini mampu mengatur penempatan teks dan gambar yang diambil
dari program lain (seperti Adobe Photoshop).

• Yang termasuk dalam kelompok ini adalah:
– Adobe FrameMaker
– Adobe In Design
– Adobe PageMaker
– Corel Ventura
– Microsoft Publisher
– Quark Xpress
– Scribus (Open Source)

15

Aplikasi Pengolah Vektor/Garis

• Program yang termasuk dalam kelompok ini dapat digunakan untuk
membuat gambar dalam bentuk vektor/garis sehingga sering disebut sebagai
Illustrator Program.

• Seluruh objek yang dihasilkan berupa kombinasi beberapa garis, baik berupa
garis lurus maupun lengkung.

• Aplikasi yang termasuk dalam kelompok ini adalah:
– Adobe Illustrator

– CorelDraw

– Beneba Canvas

– Macromedia Freehand

– Metacreations Expression

– Micrografx Designer

16
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Aplikasi Pengolah Pixel/Gambar

• Program yang termasuk dalam kelompok ini dapat dimanfaatkan untuk mengolah
gambar/manipulasi foto (photo retouching).

• Semu objek yang diolah dalam progam-program tersebut dianggap sebagai kombinasi
beberapa titik/pixel yang memiliki kerapatan dan warna tertentu, misalnya, foto.

• Gambar dalam foto terbentuk dari beberapa kumpulan pixel yang memiliki kerapatan dan
warna tertentu.

• Meskipun begitu, program yang termasuk dalam kelompok ini dapat juga mengolah teks
dan garis, akan tetapi dianggap sebagai kumpulan pixel.

• Objek yang diimpor dari program pengolah vektor/garis, setelah diolah dengan program
pengolah pixel/titik secara otomatis akan dikonversikan menjadi bentuk pixel/titik. Yang
termasuk dalam aplikasi ini adalah:
– Adobe Photoshop - Corel Photo Paint - Microsoft Photo Editor

– Macromedia Xres - Metacreations Painter - QFX

– Metacreations Live Picture - Micrografx Picture Publisher - Wright Image
17

Aplikasi Pengolah Film/Video

• Program yang termasuk dalam kelompok ini dapat dimanfaatkan untuk
mengolah film dalam berbagai macam format.

• Pemberian judul teks (seperti karaoke, teks terjemahan, dll) juga dapat diolah
menggunakan program ini.

• Umumnya, pemberian efek khusus (special effect) seperti suara ledakan,
desingan peluru, ombak, dan lain-lain juga dapat dibuat menggunakan aplikasi
ini.

• Yang termasuk dalam kategori ini adalah:

– Adobe After Effect - Power Director - Show Biz DVD

– Ulead Video Studio - Element Premier - Easy Media Creator

– Pinnacle Studio Plus - WinDVD Creater - Nero Ultra Edition

18

Aplikasi Pengolah Multimedia

• Program yang termasuk dalam kelompok ini biasanya digunakan untuk
membuat sebuah karya dalam bentuk Multimedia berisi promosi, profil
perusahaan, maupun yang sejenisnya dan dikemas dalam bentuk CD maupun
DVD.

• Multimedia tersebut dapat berisi film/movie, animasi, teks, gambar, dan
suara yang dirancang sedemikian rupa sehingga pesan yang disampaikan
lebih interaktif dan menarik.

• Yang termasuk dalam kelompok ini adalah:

– Macromedia Authorware - Macromedia Director - Ezedia

– Macromedia Flash - Multimedia Builder - Hyper Studio

19 20

Start Your Design

Langkah-langkah
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Langkah-langkah dalam Proses Desain Grafis

1. Menganalisis audiens.

2. Menentukan tujuan dan pesan Anda.

3. Memutuskan dimana dan bagaimana desain Anda akan muncul (apakah ia
akan menjadi publikasi cetak, presentasi, atau situs web).

4. Menetapkan tujuan.

5. Mengatur teks dan gambar.

6. Pilih format yang sesuai dan tata letak (usahakan ada desain alternatif).

21

Langkah-langkah dalam Proses Desain Grafis
(lanjutan)

7. Pilih sesuai typefaces, jenis ukuran, jenis gaya, dan spasi.

8. Menambah dan memanipulasi grafik/gambar.

9. Mengatur teks dan gambar.

10. Proses proofing (pemeriksaan/check).

11. Memperbaiki dan menyempurnakan.

22

23

Start Your Design

Prinsip Desain Poster

Prinsip Desain Poster

24
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Prinsip Desain Poster
(lanjutan)

25

Keseimbangan

(Balanced)

Alur Baca

(Movement)

Penekanan

(Emphasis)

Irama

(Rhythm)

Kesatuan

(Unity)

Prinsip Desain Poster
(lanjutan)

Keseimbangan (Balance)

• Keseimbangan merupakan prinsip dalam komposisi yang menghindari kesan
berat sebelah atas suatu bidang atau ruang yang diisi dengan unsur-unsur
seni rupa.

– Keseimbangan dalam warna

– Keseimbangan dalam bentuk dan ukuran

– Keseimbangan dalam posisi

– Keseimbangan dalam nilai warna dan tekstur

• Keseimbangan terbagi menjadi:

a) Keseimbangan Simetris / Formal.

b) Keseimbangan Asimetris / Non-formal
26

Prinsip Desain Poster
(lanjutan)

a. Keseimbangan simetris/formal

27

Prinsip Desain Poster
(lanjutan)

28
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Prinsip Desain Poster
(lanjutan)

b. Keseimbangan asimetris/non-formal

29

Prinsip Desain Poster
(lanjutan)

Alur Baca (Movement)

• Alur baca yang diatur secara sistematis oleh desainer untuk mengarahkan
“mata pembaca” dalam menelusuri informasi, dari satu bagian ke bagian
yang lain.

• Buat alur baca yang logis.

• Top left to bottom right

• Setting tiap bagian
• Sub judul (bold)

• Warna yang berbeda

• Direct reader’s eye
• arrows

• Highlights

30

Prinsip Desain Poster
(lanjutan)

31

Prinsip Desain Poster
(lanjutan)

Penekanan (Emphasis)

• Penekanan bisa dicapai dengan membuat judul atau illustrasi yang jauh
lebih menonjol dari elemen desain lain berdasarkan urutan prioritas.

• Macam-macam emphasis

– Perbandingan ukuran

– Latar belakang yang kontras dengan tulisan atau gambar

– Perbedaan warna yang mencolok

– Memanfaatkan bidang kosong

– Perbedaan jenis, ukuran, dan warna huruf

32
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Prinsip Desain Poster
(lanjutan)

33

Prinsip Desain Poster
(lanjutan)

34

Prinsip Desain Poster
(lanjutan)

Irama (Rhythm)

• Irama adalah pengulangan atau variasi dari komponen-komponen desain
grafis.

• Pengulangan tersebut dapat membentuk urutan gerakan, pola/pattern
tertentu.

35

Prinsip Desain Poster
(lanjutan)

36
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Prinsip Desain Poster
(lanjutan)

37

Prinsip Desain Poster
(lanjutan)

38

Prinsip Desain Poster
(lanjutan)

Kesatuan (Unity)

• Beberapa bagian dalam poster harus digabung atau dipisah sedemikian rupa
menjadi kelompok-kelompok informasi.

• Misalnya nama gedung tempat acara berlangsung, harus dekat dengan teks
alamat.

• Macam-macam unity
– Mendekatkan beberapa elemen desain

– Dibuat bertumpuk

– Memanfaatkan garis untuk pemisahan informasi

– Perbedaan informasi

– Perbedaan warna latar belakang

– Berkesinambungan 39

Prinsip Desain Poster
(lanjutan)

40
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• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Elemen-elemen Design

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang elemen-elemen dari desain pada
komputer grafis.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang penerapan
prinsip desain, dan elemen-elemen dasar dari desain.

Tujuan/Objectives (Session.06)

4
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2

Muhasabah

• Qs. Al-Isra, ayat 9
– Sungguh, Al-Qur'an ini memberi petunjuk ke (jalan) yang paling lurus dan memberi kabar gembira kepada

orang mukmin yang mengerjakan kebajikan, bahwa mereka akan mendapat pahala yang besar,

5

Komputer Grafis

Session 06

Elemen-elemen Design

7

Elemen-elemen Design

Menerapkan Prinsip Design

Tips untuk menerapkan prinsip desain

Untuk menciptakan keseimbangan:

– Ulangi bentuk tertentu secara berkala, baik secara vertikal maupun horizontal.

– Pusat elemen terdapat pada halaman.

– Menempatkan beberapa visuals kecil di satu daerah untuk menyeimbangkan satu blok
besar gambar atau teks.

– Gunakan satu atau dua bentuk aneh dan membuat bentuk biasa.

– Keringanan teks potong-berat dengan terang, berwarna-warni visual.

– Meninggalkan banyak spasi besar sekitar blok teks atau foto gelap.

– Offset besar, gelap foto atau ilustrasi dengan beberapa lembar teks kecil, masing-
masing dikelilingi oleh banyak spasi.

8
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Tips untuk menerapkan prinsip desain
(lanjutan)

Untuk membuat rhythm:

– Ulangi sejumlah elemen berbentuk mirip, bahkan dengan spasi putih di antara masing-
masing, untuk menciptakan sebuah ritme biasa.

– Ulangi rangkaian semakin besar elemen yang lebih besar dengan spasi putih di antara
setiap ritme yang progresif.

– Alternatif gelap, huruf tebal dan ringan, tipis jenis.

– Alternatif gelap halaman (dengan banyak jenis grafik atau gelap) dengan cahaya halaman
(dengan jenis lebih sedikit dan berwarna muda grafis).

– Mengulang bentuk yang sama di berbagai bidang sebuah layout.

– Ulangi elemen yang sama pada posisi yang sama pada setiap halaman yang dicetak
penerbitan seperti newsletter.

9

Tips untuk menerapkan prinsip desain
(lanjutan)

Untuk membuat penekanan:

– Gunakan rangkaian merata spaced, persegi di samping foto yang digariskan foto
dengan bentuk yang tidak biasa.

– Letakkan bagian yang penting dari teks pada sudut melengkung atau sekaligus menjaga
semua jenis yang lainnya di kolom lurus.

– Gunakan huruf tebal, hitam untuk judul dan jenis sub-heads ringan teks dan banyak
lainnya untuk semua teks.

– Tempat yang besar di sebelah gambar kecil sedikit teks.

– Reverse (gunakan jenis putih) yang utama dari sebuah kotak hitam atau berwarna.

– Gunakan warna yang tidak biasa atau jenis font yang paling penting untuk informasi.

– Letakkan daftar yang ingin Anda sorot di sidebar dalam kotak berbayang.

10

Tips untuk menerapkan prinsip desain
(lanjutan)

Untuk membuat suatu kesatuan desain:

– Gunakan hanya satu atau dua type-styles dan berbeda ukuran atau berat untuk kontras
seluruh publikasi, presentasi, atau situs web.

– Konsisten dengan jenis font, ukuran, dan gaya untuk judul, sub-heads, keterangan,
headers, footers, dll di seluruh publikasi, presentasi, atau situs web.

– Menggunakan palet warna yang sama di seluruh.

– Mengulang warna, bentuk, atau tekstur yang berbeda di seluruh wilayah.

– Pilih visuals yang berbagi serupa warna, tema, atau bentuk.

– Memperderetkan foto dan teks yang sama dengan grid baris.

11 12

Elemen-elemen Design

Elemen-elemen Desain
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Elemen-elemen Desain

• Elemen desain adalah satu hal yang terpenting dalam desain grafis.

• Hal nyata inilah yang akan mewujudkan prinsip desain.

• Layaknya sebuah tonggak yang akan menopang agar tetap kukuh.

• Elemen adalah dasar dari desain.

• Seperti halnya membangun sesuatu, kita tak bisa langsung ke atas, kita harus
mulai dari dasar. Seperti itu pula dengan desain.

13

Elemen-elemen Desain
(lanjutan)

• Elemen-elemen desain sendiri terdiri atas 6 hal, yaitu:

1) garis (line)

2) bentuk (shape)

3) tekstur (texture)

4) ruang (space)

5) ukuran (size)

6) warna (color)

14

Elemen-elemen Desain
(lanjutan)

1) Garis (line).

– Garis adalah sebuah unsur desain yang menghubungkan antara satu titik dengan titik
lainnya sehingga tergambarlah sebuah garis dengan bentuk lengkung (curve) atau lurus
(straight).

– Mampu membuat keteraturan, mengarahkan pandangan dan memberikan kesan
bergerak serta memiliki karakter tertentu.

– Penggunaan garis dapat diaplikasikan dalam pembuatan grafik atau bagan.

– Berbagai jenis garis muncul di mana-mana.

– Lihatlah di sekitar Anda dan Anda akan melihat baris yang lurus, lengkung, berbelok-
belok, tipis, tebal, dan titik-titik.

15

Elemen-elemen Desain
(lanjutan)

– Garis dapat digunakan untuk:

• Mengatur informasi.

• Penekanan kata.

• Menghubungkan informasi.

• Outline foto.

• Membuat kotak atau bangun ruang.

• Membuat bagan atau grafik.

• Membuat pola atau ritme dengan membuat banyak baris.

• Membuat penekanan langsung ke mata pembaca (membuat garis diagonal)

• Mensugesti emosi.

16
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17

Elemen-elemen Desain
(lanjutan)

2) Bentuk (shape)

– Bentuk adalah seperangkat garis yang ditempatkan berdekatan, memiliki diameter,
tinggi dan lebar. Ini merupakan obyek 2 (dua) dimensi.

– Berdasarkan sifatnya, bentuk dapat dikategorikan menjadi tiga, yaitu :

• huruf

• simbol

• bentuk nyata (form)

– Selain itu, bentuk juga dapat digunakan sebagai perantara sebuah ide.

18

Elemen-elemen Desain
(lanjutan)

– Dengan bentuk Anda dapat:

• Memodifikasi foto.

• Menyimbolkan ide.

• Membuat blok teks yang lebih
menarik dengan menetapkan teks ke
dalam bentuk.

• Buat format baru.

• Meng-highlight informasi.

19 20
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Pablo Picasso -
"Three Musicians", 

1921

21

Elemen-elemen Desain
(lanjutan)

3) Tekstur (texture)

– Tekstur merupakan sebuah visualisasi dari permukaan yang dapat dinilai dengan cara
dilihat atau diraba.

– Pada prakteknya, tekstur sering dikategorikan sebagai corak dari suatu permukaan
benda.

– Tekstur dapat menambah dimensi dan kekayaan sebuah layout, menegaskan atau
membawa ke dalam sebuah rasa/emosi tertentu.

22

Elemen-elemen Desain
(lanjutan)

– Tekstur dapat digunakan untuk:

• Memberikan publikasi cetak, presentasi, atau halaman web yang mood atau
kepribadian.

• Kontras untuk membuat bunga.

• Bermain-main mata.

• Memprovokasi emosi.

• Membuat rasa dan memberikan kekayaan mendalam.

23 24
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25

Elemen-elemen Desain
(lanjutan)

4) Ruang (space)

– Ruang adalah jarak yang memisahkan antar sesuatu.

– Biasanya digunakan memisahkan atau menyatukan elemen-elemen layout.

– Ruang juga berfungsi sebagai tempat istirahat bagi mata.

– Dalam bentuk fisiknya, pengidentifikasian ruang digolongkan menjadi dua unsur, yaitu:

• obyek (figure)

• latar belakang (background).

26

Elemen-elemen Desain
(lanjutan)

– Ruang dapat digunakan untuk:

• Memberikan mata visual istirahat.

• Membuat hubungan antara unsur-unsur.

• Sorot salah satu elemen.

• White or negative space help frame and contain the design.

• It avoids visual clutter, looks “clean”.

• It can also help to focus the viewer on something specific.

• Helps keep flow going.

27 28
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31

Elemen-elemen Desain
(lanjutan)

5) Ukuran (size)

– Ukuran adalah seberapa besar atau kecil sesuatu hal.

– Perbandingan ukuran satu bentuk terhadap bentuk lainnya.

– Dengan menggunakan elemen ini kamu dapat menciptakan kontras dan penekanan
(emphasis) pada obyek desain, sehingga orang akan tahu sisi menarik atau menonjol
dari desain itu dan melihatnya terlebih dahulu.

32
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Prinsip Desain Poster
(lanjutan)

33

Elemen-elemen Desain
(lanjutan)

6) Warna (color)

– Warna merupakan media paling akhir dalam komunikasi simbolik dan yang terpenting.

– Nyatanya, warna dibagi ke dalam dua section, yaitu:

• Warna yang timbul karena sinar (Additive color / RGB)
– biasanya digunakan pada warna lampu, monitor, TV dan sebagainya,

• Warna yang dibuat dalam unsur tinta atau cat (Substractive color / CMYK).
– biasanya digunakan dalam proses pencetakan gambar ke permukaan benda padat seperti kertas,

logam, kain atau plastik.

– Dengan menggunakan warna, si desainer dapat menampilkan identitas, menyampaikan
pesan, atau menarik perhatian serta menegaskan sesuatu.

34

Elemen-elemen Desain
(lanjutan)

35
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Komputer Grafis

Session 08

PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Lingkup Profesi Desain

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang ruang lingkup profesi desain pada
komputer grafis.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang definisi
komunikasi, desain komunikasi visual, tujuan , dan lingkup profesi dari desain.

Tujuan/Objectives (Session.08)

4
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Muhasabah

• Qs. Al Baqarah, ayat 120
– Dan orang-orang Yahudi dan Nasrani tidak akan rela kepadamu (Muhammad) sebelum engkau mengikuti

agama mereka. Katakanlah, “Sesungguhnya petunjuk Allah itulah petunjuk (yang sebenarnya).”

– Dan jika engkau mengikuti keinginan mereka setelah ilmu (kebenaran) sampai kepadamu, tidak akan ada
bagimu pelindung dan penolong dari Allah.

5

Komputer Grafis

Session 08

Ruang Lingkup Desain

7

Lingkup Profesi Desain

Definisi Komunikasi

Definisi Komunikasi

Komunikasi: Tindakan atau proses transmisi informasi, gagasan, emosi, 
keterampilan, dsb, dengan menggunakan simbol-simbol (kata-kata, gambar, figur, 

grafik, dsb). Bernard Berelson & Gary A. Steiner.

Komunikasi: Proses yang memungkinkan seseorang menyampaikan

rangsangan (melalui bahasa verbal atau non verbal) untuk mengubah

perilaku seseorang. Carl I. Hovland

8
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Definisi Komunikasi
(lanjutan)

• Agar proses komunikasi berjalan, menurut Wilbur Scharmm, setidaknya
dibutuhkan tiga unsur, yaitu:

• Sumber (source)

• Pesan (message)

• Sasaran (destination)

9

Definisi Komunikasi
(lanjutan)

10

11

Lingkup Profesi Desain

Desain Komunikasi Visual

Desain Komunikasi Visual

Desain Komunikasi Visual

• Suatu disiplin ilmu yang mempelajari bagaimana penyampaian pesan atau
informasi melalui bahasa visual (rupa) dengan mempertimbangkan media,
nilai sosial, citra, dsb.

12
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Desain Komunikasi Visual
(lanjutan)

• Seorang desainer komunikasi
visual dituntut untuk dapat
menemukan pemecahan yang
tepat, serta pengolahan
dengan imajinasi yang kreatif
dan mampu mewujudkannya
dalam rupa (bentuk) yang
komunikatif sehingga pesan
dapat disampaikan secara
efektif.

13 14

Lingkup Profesi Desain

Tujuan & Ruang Lingkup

Tujuan Desain Komunikasi Visual

• Identitas (jati diri).

• Bentuk visual digunakan untuk menandai seseorang maupun aspirasi
sebuah kelompok.

• Informasi (penerangan).

• Sifatnya memberitahu agar audiens mendapat suatu pengertian.

• Persuasi (pembujukan).

• Difungsikan untuk mempengaruhi audiens sehingga mengikuti saran dari
pemberi pesan.

15

Lingkup Profesi Desain Komunikasi Visual

• Desain grafis periklanan (advertising)

• Desain identitas usaha (corporate identity)

• Desain marka lingkungan (environmental graphics)

• Desain grafis media penerbitan (publishing)

• Ilustrasi

• Fotografi

• Animasi

• Desain multimedia

• Desain permainan (games)

16
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Identity

17

Sign System

18

Publishing

19

illustration

20
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Photography

21

Environmental Graphics

22

Game Design

23

Multimedia

24
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Advertising

25

Promotion

26

Social Campaign

27

Social Campaign
(lanjutan)

28
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Komputer Grafis

Session 10

PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Desain Kemasan Produk

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang desain kemasan pada komputer grafis.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang fungsi desain
kemasan, dan tips desain kemasan produk.

Tujuan/Objectives (Session.10)

4



18/09/2023

2

Muhasabah

• Qs. Fussilat, ayat 37
– Dan sebagian dari tanda-tanda kebesaran-Nya ialah malam, siang, matahari dan bulan.

– Janganlah bersujud kepada matahari dan jangan (pula) kepada bulan, tetapi bersujudlah kepada Allah yang
menciptakannya, jika kamu hanya menyembah kepada-Nya.

5

Komputer Grafis

Session 10

Desain Kemasan Produk

7

Desain Kemasan Produk

Pendahuluan

Pendahuluan

• Desain kemasan produk merupakan salah
satu faktor penting yang dapat menguatkan
branding bisnis dalam persaingan yang
semakin ketat.

• Desain kemasan yang menarik dan
berkualitas menjadi pembeda antara brand
produk Anda dengan produk kompetitor.

8
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Pendahuluan
(lanjutan)

• Melalui desain kemasan produk, Anda dapat menyampaikan informasi
mengenai identitas bisnis, misalnya seperti logo, kualitas produk, dan
sebagainya.

• Hal seperti ini tentu bisa menarik perhatian pelanggan untuk jatuh cinta pada
produk Anda.

• Penting untuk diketahui, sebuah kemasan produk yang menarik tak harus
mahal dan juga tak harus rumit, Anda hanya perlu menjadi kreatif dan
mengerti keseimbangan antara efisiensi dan efektivitas.

• Desain kemasan produk yang menarik dan unik tentu mempunyai karakter
yang akan membedakan dengan produk serupa lainnya.

9 10

Desain Kemasan Produk

Fungsi Desain Kemasan Produk

Fungsi Desain Kemasan Produk

• Sebuah desain yang menarik harus dapat merefleksikan nilai-nilai dari produk itu
sendiri dan juga bisnis Anda.

• Bagi pelaku bisnis yang sudah berpengalaman, tentu hal ini sangat diperhatikan
karena dapat membantu proses pemasaran, sehingga dapat meningkatkan
penjualan.

11

Fungsi Desain Kemasan Produk
(lanjutan)

Desain kemasan produk yang menarik, dapat berfungsi :

• Menjaga kualitas barang di dalamnya.
• Untuk makanan maka menjadi lebih awet, pakaian menjadi tidak kusut, alat elektronik tetap

aman terjamin dan bisa digunakan.

• Membantu pemasaran.
• Karena dalam desain kemasan tersebut tercantum informasi penting seperti merk bisnis, jenis

produk, label produk, expire date, kandungan gizi, serta alamat dan keterangan produsen.

• Meningkatkan brand awereness dan kualitas produk tersebut.
• Karena makin dikenal sekaligus dipercaya oleh konsumen dan juga calon konsumen baru.

12
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Fungsi Desain Kemasan Produk
(lanjutan)

13

Fungsi Desain Kemasan Produk
(lanjutan)

14

15

Desain Kemasan Produk

Tips Desain Kemasan Produk

Tips Desain Kemasan Produk

1. Pilih Warna Yang Tepat

• Warna kemasan suatu produk sangat penting, hampir 90% dari pembelian
didasarkan hanya pada warna.

• Jadi, kita harus mengetahui peran dan arti warna dalam desain kemasan,
misalnya:
• Merah melambangkan hasrat, kekuatan, cinta dan keberanian

• Kuning melambangkan energi, serta kebahagiaan

• Oranye melambangkan kesan senang, kehangatan, atau tekad

• Hijau melambangkan kesegaran, alam, atau uang

• Biru melambangkan ketenangan, otoritas, atau maskulinitas

• Ungu melambangkan kreativitas, royalti, atau misteri

• Merah mudah melambangkan rasa ramah, feminitas
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Tips Desain Kemasan Produk
(lanjutan)

2. Pilih Bentuk Kemasan yang Sesuai.

• Anda mungkin pernah memperhatikan bahwa kemasan untuk produk “maskulin”
sering memiliki bentuk persegi panjang, seperti kotak, sementara banyak produk
“feminim” seringkali lebih melengkung, ternyata itu bukanlah kebetulan.

• Ada pertimbangan psikologi dalam bentuk kemasan tersebut, tersembunyi di
balik target pasar Anda, untuk itu Anda dapat membuat desain kemasan sesuai
dengan itu.

• Meskipun desain yang menonjol itu penting, namun perlu juga diingat bagaimana
produk kamu dapat bersaing di industri ritel.

17

Tips Desain Kemasan Produk
(lanjutan)

3. Perhatikan Kemasan Produk Lainnya

• Hal ini dapat membantu anda mendapatkan inspirasi. Karena tidak ada yang lebih
baik daripada melakukan riset lapangan dan melihat-lihat desain kemasan
kompetitor.

• Anda akan menyadari ada banyak sekali jenis desain kemasan di pasaran, seperti
display box, pillow box, slide box, dan masih banyak yang lain.

• Pilih tipe kemasan yang sesuai dengan karakteristik produk anda. Selain itu, pilih
kemasan yang harganya sesuai perhitungan budget anda.

18

Tips Desain Kemasan Produk
(lanjutan)

4. Buatlah Desain Yang Memorable

• Terkadang desain yang bagus saja tidaklah cukup. Anda harus membuat desain
kemasan produk yang memorable alias mampu diingat oleh konsumen.

• Apabila produk anda sudah masuk ke pikiran konsumen, maka besar kemungkinan
mereka akan mengingat produk anda saat sedang membutuhkannya.

• Untuk membuat desain kemasan produk yang memorable, anda perlu memperhatikan
beberapa hal.

• Pertama, sampaikan pesan produk anda secara jelas melalui logo, gambar, tulisan, dan
warna pada label kemasan.

• Informasi tersebut harus disusun supaya ringkas, jelas, dan mudah dibaca. Jika
informasinya dapat menyentuh sisi emosi, maka hal itu akan lebih bagus.

19

Tips Desain Kemasan Produk
(lanjutan)

5. Buat Agar Mudah Dimengerti

• Calon pelanggan Anda perlu “mengerti” produk kamu dengan cepat.

• Anda hanya memiliki beberapa detik untuk membuat produk Anda dapat
dipahami oleh pelanggan saat pertama kali melihatnya.

• Salah satu caranya yakni menggunakan bahasa yang sederhana, cara ini sangat
penting untuk meningkatkan kemungkinan seseorang akan memahami apa yang
Anda jual dan membuat mereka lebih cenderung untuk membelinya.
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Tips Desain Kemasan Produk
(lanjutan)

6. Gunakan Kalimat Sederhana

• Pada desain kemasan makanan, seringkali ditemukan berbagai tulisan selain komposisi
ataupun identitas barang itu sendiri.
• Misalnya saja kalimat slogan, kata-kata persuasif, nama brand, dan lainnya.

• Meskipun ingin dibuat menarik tetapi hindari penggunaan kalimat berlebihan, alay,
atau kurang penting yang mampu membuat bingung para konsumen.

• Pakailah gaya bahasa sederhana, mudah diingat tetapi mampu mengintepretasikan
tujuan maupun produk tersebut.

• Dengan mengetahui rahasia membuat desain packaging produk yang bagus maka
keuntungan bisnis Anda dapat bertambah besar.
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Tips Desain Kemasan Produk
(lanjutan)

7. Tambahkan Simbol, Barcode, dan Stiker Promo

• Jangan remehkan elemen-elemen lain yang bisa membantu produk anda terlihat
lebih menarik. Anda bisa menambahkan simbol, barcode, dan stiker promo pada
desain kemasan produk.

• Simbol-simbol tertentu, seperti logo halal ataupun cap ‘100% natural’ dapat
menjadi nilai tambah produk anda.

• Barcode juga demikian. Selain digunakan untuk mempermudah scanning,
barcode dapat menciptakan kesan trusted pada produk.

• Begitu pula dengan stiker promo. Apabila anda punya program promo, jangan
ragu untuk mencantumkannya pada desain kemasan.

22

Tips Desain Kemasan Produk
(lanjutan)
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Komputer Grafis

Session 12

PROGRAM STUDI ILMU KOMUNIKASI

2

• VISI.
√ Program studi Ilmu Komunikasi utama yang unggul di tingkat nasional pada 2022 dalam menghasilkan

sarjana ilmu komunikasi yang memiliki kecerdasan spiritual, intelektual, emosional, dan sosial serta berjiwa
entrepreneur yang islami.

• MISI.
1. Menyelenggarakan kegiatan pendidikan dan pengajaran yang bermutu untuk menghasilkan sarjana yang

unggul dan kompetitif.

2. Menyelenggarakan dan mengembangkan penelitian Ilmu komunikasi dengan memanfaatkan aplikasi
teknologi informasi.

3. Melaksanakan kegiatan pengabdian pada masyarakat sebagai salah satu proses pemantapan dan
pemanfaatan ilmu untuk masyarakat, khususnya yang berkaitan dengan komunikasi massa, humas,
periklanan, penyiaran, dan manajemen komunikasi.

4. Mengintegrasikan nilai-nilai Islam dan Kemuhammadiyahan dalam ilmu pengetahuan dan teknologi,
menuju keluhuran akhlak.

• SKS : 2
– Teori 2 SKS – (14 Kali Pertemuan)

• Keaktifan (bobot 10%)
– Terdiri dari: Aktivitas Perkuliahan (Kehadiran, Etika, dan Sikap).

• Project (bobot 20%)
– Terdiri dari: Tugas Besar / Project (Penguasaan Keterampilan) dengan cara observasi,

mengimplementasikan dan menghasilkan Proyek Akhir, serta mempresentasikannya.

• Tes (UTS = bobot 30% , UAS = bobot 40%)
– Terdiri dari: UTS dan UAS (Penguasaan Pengetahuan) dengan cara tes tertulis maupun tes

praktikum.

Sistem Penilaian

3

• Objectives (Tujuan Instruksional Umum).
– RPS/SAP.

– Cara Berfikir Desain

• Indikator Kompetensi.

– Mahasiswa mengetahui dan memahami tentang cara berfikir desain.

– Mahasiswa mengetahui, memahami, serta dapat menjelaskan tentang cara berfikir
desain, dan metode berfikir desain.

Tujuan/Objectives (Session.12)

4
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2

Muhasabah

• Qs. Ali Imran, ayat 97
– Di sana terdapat tanda-tanda yang jelas, (di antaranya) maqam Ibrahim.

– Barangsiapa memasukinya (Baitullah) amanlah dia. Dan (di antara) kewajiban manusia terhadap Allah adalah
melaksanakan ibadah haji ke Baitullah, yaitu bagi orang-orang yang mampu mengadakan perjalanan ke sana.

– Barangsiapa mengingkari (kewajiban) haji, maka ketahuilah bahwa Allah Mahakaya (tidak memerlukan sesuatu)
dari seluruh alam.

5

Komputer Grafis

Session 12

Cara Berfikir Desain

7

Cara Berfikir Desain

Pendahuluan

Pendahuluan

• Secara umum, dalam aktivitas kehidupan manusia dikenal tiga kategori cara
berpikir, yaitu:

1) Berpikir Logis

2) Berpikir Intuitif

3) Berpikir Prosedural

8
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Pendahuluan
(lanjutan)

1) Berpikir Logis

• Pikiran yang terarah pada
suatu jawaban atau
kesimpulan serta penciptaan
suatu konsep dengan
mengacu pada data atau
fakta yang rasional.

9

Pendahuluan
(lanjutan)

2) Berpikir Intuitif

• Pikiran intuitif berorientasi
pada hal-hal yang tidak
logis, antara lain perasaan,
selera, emosi, insting,
bahkan tahayul.

10

Pendahuluan
(lanjutan)

11

Pendahuluan
(lanjutan)

3) Berpikir Prosedural

• Proses menilai kembali keputusan yang telah ditetapkan, dan bilamana
perlu mengambil keputusan baru.

12
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Pendahuluan
(lanjutan)

13

Pendahuluan
(lanjutan)

• Metodologi desain mengistilahkan tiga cara berpikir sebagai :

a) Metode Kotak Kaca (Glass Boxes)

b) Metode Kotak Hitam (Black Boxes)

c) Metode Pengorganisasian Diri (Self-Organizing System)

• Ketiga metode ini digunakan untuk melakukan telaah teoritis dalam
mengeksplorasi kemungkinan-kemungkinan serta gagasan-gagasan menuju
keputusan akhir suatu desain.

14

15

Cara Berfikir Desain

Glass Box Method

Glass Box Method

• Metode kotak kaca, atau yang lebih dikenal dengan glass box method.

• Adalah metode berpikir rasional yang secara obyektif dan sistematis menelaah
sesuatu hal secara logis dan terbebas dari pikiran dan pertimbangan yang tidak
rasional (irasional).

• Misalnya sentimen dan selera.

• Metode ini selalu berusaha untuk menemukan fakta-fakta dan sebab atau
alasan faktual yang melandasi terjadinya suatu hal atau kejadian dan kemudian
berusaha menemukan alternatif solusi atas masalah-masalah yang timbul.

16
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Glass Box Method
(lanjutan)

17

Glass Box Method
(lanjutan)

18

19

Cara Berfikir Desain

Black Box Method

Black Box Method

• Metode berpikir intuitif dan disebut pula sebagai imagining.

• Ciri:

• Sasaran desain tidak ditentukan secara pasti dan bisa berubah sesuai
perkembangan pikiran desainer maupun tambahan masukan data.

• Keputusan desainer dikendalikan oleh masukan data terakhir tentang
masalah yang dihadapi, juga masukan dari kasus-kasus lain yang hampir
sama atau setara (analogi), ditambah dengan masukan dari pengalaman diri
desainer sendiri.

20
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Black Box Method
(lanjutan)

21

Black Box Method
(lanjutan)

• Keputusan desainer dikendalikan oleh masukan data terakhir tentang masalah
yang dihadapi, juga masukan dari kasus-kasus lain yang hampir sama atau setara
(analogi), ditambah dengan masukan dari pengalaman diri desainer sendiri.

• Dalam benaknya desainer mencerna dan memanipulasi citra yang
merepresentasikan struktur persoalan secara menyeluruh, kemudian dengan
cara yang sering tidak dapat diduga mentransformasikan masalah yang rumit
menjadi sederhana clan sekaligus menghasilkan keputusan akhir.

• Dalam metodologi desain, proses seperti ini sering disebut leap of insight.

• Langkah-langkah pemikiran desainer dalam proses eksplorasi kotak hitam antara
lain berupa analogi, aplikasi, spekulasi dan intuisi.

22
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Cara Berfikir Desain

Self-Organizing Method

Self-Organizing Method

• Memilah-milah permasalahan menjadi bagian-bagian atau komponen-
komponen yang dapat ditelaah secara logis dan analitis dengan metode kotak
kaca.

• Berdasar komponen-komponen yang dihasilkan oleh telaah tersebut maka
keputusan akhir diambil secara intuitif menggunakan metode kotak hitam.

• Berdasar kenyakinan teoritis itulah, maka lebih jauh Imam Buchori menjelaskan
pendekatan kreatif konvergen dan divergen yang dinilai sangat signifikan dalam
memecahkan masalah komunikasi visual.
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Self-Organizing Method
(lanjutan)

1). Pendekatan Konvergen

• Konsep ini senantiasa mengedepankan ketrampilan sebagai panglimanya.

• Keberadaannya diramu dengan intuisi dan citarasa yang tinggi untuk mengolah bahan.

• Cara semacam ini tidak terlalu mempermasalahkan faktor eksternal selain yang ia kuasai.

• Pendekatan konvergen menisbikan masalah-masalah material dan kemungkinan
bentukannya.

• Tujuan hanya satu: mencari keunikan dan keindahan.

• Oleh kaum metodologis, ungkap Iman Buchori, cara seperti itu disebut dengan
pendekatan tradisional.

25

Self-Organizing Method
(lanjutan)

2). Pendekatan divergen.

• Artinya, ia bekerja dengan merumuskan (menganalisis) seluruh permasalahan yang ada.

• Mencari sintesisnya, dan melakukan evaluasi.

• Pendekatan kreatif konvergen dan divergen merupakan gabungan proses
berfikir kreatif yang menggabungkan pendekatan tradisional dengan
mengedepankan ketrampilan sebagai panglimanya yang diramu pendekatan
modern dengan acuan analisis, sintesis dan evaluasi sebagai ujung
tombaknya.
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